Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

<table>
<thead>
<tr>
<th><strong>DANGER</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>indicates that death or severe personal injury <strong>will</strong> result if proper precautions are not taken.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>WARNING</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>indicates that death or severe personal injury <strong>may</strong> result if proper precautions are not taken.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>CAUTION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>indicates that minor personal injury can result if proper precautions are not taken.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>NOTICE</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>indicates that property damage can result if proper precautions are not taken.</td>
</tr>
</tbody>
</table>

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by **personnel qualified** for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

<table>
<thead>
<tr>
<th><strong>WARNING</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.</td>
</tr>
</tbody>
</table>

Trademark

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1 Security information..............................................................................................................................5
2 Preface..................................................................................................................................................7
3 System Requirements..........................................................................................................................9
   3.1 Hardware Requirements..............................................................................................................9
   3.2 Released modules......................................................................................................................12
   3.3 System requirements...............................................................................................................13
   3.4 Installation...............................................................................................................................16
4 Licenses............................................................................................................................................17
5 Differences between PCS 7 SMART and PCS 7 ASIA........................................................................23
   5.1 Differences between PCS 7 SMART and PCS 7 ASIA.............................................................23
   5.2 Overview of differences...........................................................................................................24
   5.3 Process objects.........................................................................................................................25
   5.4 ES - Functions.........................................................................................................................26
   5.5 STEP 7.......................................................................................................................................27
      5.5.1 STEP 7 - User interface......................................................................................................27
      5.5.2 STEP 7 - Functions.............................................................................................................27
   5.6 OS (WinCC)..............................................................................................................................28
      5.6.1 OS (WinCC) - User interface...............................................................................................28
      5.6.2 OS (WinCC) - Functions......................................................................................................28
      5.6.3 OS (WinCC) - Supported hardware.....................................................................................29
6 Switching from PCS 7 SMART to PCS 7 ASIA..................................................................................31
   6.1 Installation of PCS 7 ASIA.........................................................................................................31
   6.2 Migrating projects......................................................................................................................37
7 Hardware catalog..................................................................................................................................39
8 Updating from PCS 7 SMART V8.x to PCS 7 SMART V9.0..............................................................41
   8.1 Upgrading to PCS 7 SMART V9.0............................................................................................41
Index.....................................................................................................................................................45
Siemens provides products and solutions with industrial security functions that support the secure operation of plants, systems, machines, and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. Siemens’ products and solutions only form one element of such a concept.

Customer is responsible to prevent unauthorized access to its plants, systems, machines and networks. Systems, machines and components should only be connected to the enterprise network or the internet if and to the extent necessary and with appropriate security measures (e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be taken into account. For more information about industrial security, please visit:


Siemens’ products and solutions undergo continuous development to make them more secure. Siemens strongly recommends to apply product updates as soon as available and to always use the latest product versions. Use of product versions that are no longer supported, and failure to apply latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed under

PCS 7 SMART

PCS 7 SMART is a powerful process control system which introduces you to process automation. Even less experienced users can build an automation system and benefit from the advantages of automation technology with this easy-to-use system.

PCS 7 SMART is suitable for companies that need cost-efficient automation for small plant configurations.

Purpose of this documentation

This documentation highlights the differences between the PCS 7 SMART process control system and PCS 7 ASIA.

Guide

The PCS 7 SMART documentation also includes references to the PCS 7 documentation in addition to descriptions of the differences. This enables you to quickly access the required PCS 7 functions. You can find important key words in the index.

Options for accessing PCS 7 documentation

Full versions of the documentation are available on the Internet pages of the "SIMATIC PCS 7 Technical Documentation (www.siemens.com/pcs7-documentation)".

PCS 7 SMART Readme (offline)

The PCS 7 SMART Readme on the DVD contains important information about PCS 7 SMART and takes precedence over the documentation that has been supplied with the PCS 7 SMART. After installation of PCS 7 SMART, you will find the document Process Control System PCS 7; PCS 7 Readme in the Windows Start menu under the following path:

Siemens Automation > Documentation > Readmes <language>

PCS 7 SMART Readme (online)

The information provided in the PCS 7 SMART Readme (online) on the Internet takes precedence over all PCS 7 SMART documentation.

Please read this PCS 7 SMART Readme (online) carefully; it contains important information and amendments on PCS 7 SMART.
Documentation for PCS 7 on the Internet (current versions)

The latest documentation on the PCS 7 versions is available on the Internet page "Technical Documentation SIMATIC PCS 7":

- In the section "Software manuals for SIMATIC PCS 7 ..."
  - The link to the latest system and product documentation of the particular PCS 7 version.
  - The link to download the Setup for the latest system documentation "PCS 7 Documentation Portal Setup" (SIMATIC PCS 7 online help).
    The Manual Collection includes the manuals for hardware and software.

Required basic knowledge

General knowledge in the area of automation engineering and basic knowledge of PCS 7 is required to understand this documentation. It is also assumed that the reader knows how to use computers or other equipment similar to PCs (such as programming devices) with the Windows operating system. The configuration manuals and the Getting Started documentation for PCS 7 will provide you with basic information regarding the use of PCS 7.

Conventions

In this documentation, the names of software interface elements are specified in the same language used for this documentation. If you have installed a multi-language package for the operating system, some of the designations will still be displayed in the basic operating system language, even after changing the language. They will therefore differ from the designations used in the documentation.
3.1 Hardware Requirements

PC

The SIMATIC IPC 347E is a custom-fit option for PCS 7 SMART projects.

The SIMATIC IPC 347E has the following product features:

<table>
<thead>
<tr>
<th>Component IPC 347E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article No.</td>
</tr>
<tr>
<td>Chip set</td>
</tr>
<tr>
<td>Processor</td>
</tr>
<tr>
<td>RAM</td>
</tr>
<tr>
<td>HDD</td>
</tr>
<tr>
<td>ODD</td>
</tr>
<tr>
<td>Operating system</td>
</tr>
</tbody>
</table>

Automation systems

PCS 7 SMART supports the following CPUs:

- CPU 410-5H FW V8.1/V8.2
- CPU 410 SMART FW V8.1/V8.2
- CPU 410E FW V8.2

Comparison of CPUs

<table>
<thead>
<tr>
<th></th>
<th>CPU 410-5H</th>
<th>CPU 410 SMART</th>
<th>CPU 410 E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process objects (inclusive)</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Process objects (maximum)</td>
<td>2600 (in conjunction with PCS 7 SMART, a maximum of 2400 POs can be used)</td>
<td>800 (Fixed limitation)</td>
<td>200 (Fixed limitation)</td>
</tr>
<tr>
<td>Load Memory</td>
<td>48MB</td>
<td>48MB</td>
<td>48MB</td>
</tr>
<tr>
<td>Work Memory (no separation of code and data)</td>
<td>32MB</td>
<td>8MB</td>
<td>4MB</td>
</tr>
<tr>
<td>Inputs/outputs</td>
<td>16000 byte input</td>
<td>1536 byte input</td>
<td>1536 byte input</td>
</tr>
</tbody>
</table>
### System Requirements

#### 3.1 Hardware Requirements

<table>
<thead>
<tr>
<th></th>
<th>CPU 410-5H</th>
<th>CPU 410 SMART</th>
<th>CPU 410 E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle time of OB3x</td>
<td>10 ms to 5s</td>
<td>10 ms to 5s ≥ FW V8.1.3</td>
<td>10 ms to 5s</td>
</tr>
<tr>
<td><strong>Functionality</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HF-CPU (process safety &amp; redundancy)</td>
<td></td>
<td>No F (process safety), H only</td>
<td>HF-CPU (process safety &amp; redundancy)</td>
</tr>
<tr>
<td>Time stamp &amp; sequence of event (SOE)</td>
<td></td>
<td>No SOE (time stamp OB4x)</td>
<td>Time stamp &amp; sequence of event (SOE)</td>
</tr>
<tr>
<td><strong>Interfaces</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DP master with max. 96 DP slaves</td>
<td></td>
<td>1x DP with max. 48 DP slaves</td>
<td>DP master with max. 96 DP slaves</td>
</tr>
<tr>
<td>Up to 10x external DP master</td>
<td></td>
<td>No external DP master</td>
<td>Up to 10x external DP master</td>
</tr>
<tr>
<td>2x PN IO controller, in each case with 250 devices or 2x Ethernet or 1x Ethernet &amp; 1x PN IO controller</td>
<td></td>
<td>2x PN IO controller, in each case with 48 devices or 2x Ethernet or 1x Ethernet &amp; 1x PN IO controller</td>
<td>2x PN IO controller, in each case with 250 devices or 2x Ethernet or 1x Ethernet &amp; 1x PN IO controller</td>
</tr>
<tr>
<td><strong>Conformal coating</strong></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Configuration options</strong></td>
<td>Freely configurable</td>
<td>Fixed bundles (rack + PS + CPU)</td>
<td>Freely configurable</td>
</tr>
</tbody>
</table>

Additional CPU types are **not** offered in the "STEP 7 HW Configuration".

It is **not** possible to download a program to other CPUs (e.g., S5, S7-300, S7-412/414/416/417, etc.).

### System Expansion Card (SEC)

**CPU 410 SMART**

You need a system expansion card to operate a CPU 410 SMART. It is **not** possible to upgrade the process object (PO). The maximum number of POs is limited to 800 and cannot be increased or amended. The system expansion card forms a hardware unit with the CPU 410 SMART. In redundant operation you must use two 410 SMART CPUs that are each equipped with a system expansion card with the same PO quantity.

**CPU 410-5H**

You need a system expansion card to operate a CPU 410-5H. The system expansion card specifies the maximum number of process objects that can be downloaded. If necessary, the specified volumes of the system expansion card can be increased using the CPU 410 expansion packs. The system expansion card forms a hardware unit with the CPU 410-5H. In redundant operation you must use two 410-5H CPUs that are each equipped with a system expansion card with the same PO quantity.
CPU 410 E

You need a system expansion card to operate a CPU 410 E. The number of POs is fixed to 200 and cannot be increased or amended. The system expansion card forms a hardware unit with the CPU 410 E. In a redundant operation, you must use two 410 E CPU’s which are equipped with a system expansion card with the same PO quantity.
3.2 Released modules

PCS 7 SMART cannot be used with S7-400 CPU types. All other modules, which are also released for PCS 7 ASIA, can be used. You can find a detailed list of approved modules on the Internet in the SIMATIC PCS 7 System Documentation (www.siemens.com/pcs7-documentation) in the manual "Released Modules" under "Software manuals for SIMATIC PCS 7".

Note

If you use a CPU 410 SMART, the following limitations apply:

- You cannot operate failsafe modules
- You cannot use the SOE (sequence of event) function
3.3 System requirements

Operating system

PCS 7 SMART supports the following operating systems:

- Windows 7 Ultimate / Enterprise SP1 (64-Bit)
- Windows 7 Professional SP1 (64-Bit, English version only)
- Windows 10 Enterprise 2015 LTSB (64-Bit)

PCS 7 SMART does not support any other operating systems.

PCS 7 SMART can be expanded with all standard products (e.g., SIMATIC Process Historian, SIMATIC BATCH, etc.). If these products require a different operating system, install the standard products on a separate computer.

You can find further information on supported operating systems of the standard products documentation (https://support.industry.siemens.com/cs/en/ps/21144) in the manual “PCS 7 SMART readme online” in the section “Installation instructions”.

System configuration

PCS 7 SMART does not support client-server architectures.

- The figure below is an example of the minimum configuration:

![Diagram of minimum configuration](image)

Combined plant/terminal bus

Note

**OS simulation on an engineering station**

An OS simulation on an engineering station requires an OS runtime license.
The architecture can be as follows:

- 1 OS single station system and up to 6 additional OS single station system references
- 1 OS single station system and 1 redundant OS single station system (single station system + single station system standby)

You can find additional information about the PCS 7 ASIA plant configuration on the Internet (https://support.industry.siemens.com/cs/ww/en/view/24023824). Please note the differences in the configuration limits between PCS 7 ASIA and PCS 7 SMART.

Configuration limits:

- Only one OS project can be created
- The same project runs on each OS
- Maximum volume for AS process objects per project: 2400 POs
- Maximum volume for OS process objects per project: 2400 POs
- Only CPU 410-5H, CPU 410 SMART and CPU 410 E can be used
- Maximum of 3 web clients simultaneously per web server in one OS single station system
- Client/server configuration is not supported

PCS 7 ASIA and PCS 7 SMART comparison

For more information on PCS 7 ASIA and PCS 7 SMART comparison, refer to Differences between PCS 7 SMART and PCS 7 ASIA (Page 23)
Selecting components to be used in your plant

You can find information on selecting system components in the documentation (www.siemens.com/pcs7-documentation) "Software manuals for SIMATIC PCS 7", section "PCS 7 Plant Components" in the manual "PCS 7 Engineering System" under "SIMATIC PCS 7 system documentation".
## 3.4 Installation

### Language combinations

The PCS 7 SMART setup offers the following language configurations:

<table>
<thead>
<tr>
<th>System language</th>
<th>Selected user interface language in PCS 7 setup</th>
<th>Languages available for PCS 7 SMART</th>
<th>Language of installed libraries</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chinese (simplified)</td>
<td>English</td>
<td>English (default)</td>
<td>Chinese</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chinese (optional)</td>
<td></td>
</tr>
<tr>
<td>Chinese (simplified)</td>
<td>Chinese (simplified)</td>
<td>English (default)</td>
<td>Chinese (simplified)</td>
</tr>
<tr>
<td>English</td>
<td>English</td>
<td>English (default)</td>
<td>English</td>
</tr>
</tbody>
</table>

### Installation of PCS 7 SMART

Start the file Setup.exe on the installation disk and follow the instructions.
## Scope of delivery for the PCS 7 SMART bundles

Below is an overview of the bundles that are available for PCS 7 SMART. The brackets after the "✓" symbol indicate the number of components contained. The brackets after the package name indicate the article number of the package.

<table>
<thead>
<tr>
<th>Package name → Component ↓</th>
<th>Standard bundle (6ES7650-6BB58-0XX0)</th>
<th>Redundant bundle (6ES7650-6BB58-0XX2)</th>
<th>Standard bundle w/o IPC (6ES7650-6AB58-0XX0)</th>
<th>Redundant bundle w/o IPC (6ES7650-6AB58-0XX2)</th>
<th>Standard bundle w/ CPU 410-5H (6ES7650-6BA58-0XX0)</th>
<th>Redundant bundle w/ CPU 410-5H (6ES7650-6BA58-0XX2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPC 347E¹</td>
<td>✓ (1)</td>
<td>✓ (3)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU 410 SMART Bundle</td>
<td>✓ (1)²</td>
<td>✓ (2)³</td>
<td>✓ (1)²</td>
<td>✓ (2)³</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU 410 Bundle³</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓ (1)</td>
<td></td>
</tr>
<tr>
<td>CPU 410 Redundant Bundle⁴</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓ (1)</td>
</tr>
<tr>
<td>CPU Sync Module</td>
<td></td>
<td></td>
<td>✓ (4)</td>
<td>✓ (4)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patch cable for Synch Mod- ules 1 m</td>
<td>✓ (2)</td>
<td>✓ (2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCALANCE XB 208⁵</td>
<td>✓ (1)</td>
<td>✓ (1)</td>
<td></td>
<td></td>
<td></td>
<td>✓ (1)</td>
</tr>
<tr>
<td>IM PA SMART</td>
<td>✓ (1)</td>
<td>✓ (2)</td>
<td>✓ (1)</td>
<td>✓ (2)</td>
<td>✓ (1)</td>
<td>✓ (2)</td>
</tr>
<tr>
<td>Backplane Module for 1x IM and 1x PS</td>
<td>✓ (1)</td>
<td>✓ (1)</td>
<td></td>
<td></td>
<td></td>
<td>✓ (1)</td>
</tr>
<tr>
<td>Backplane Module for 2x IM</td>
<td>✓ (1)</td>
<td></td>
<td>✓ (1)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SoftNet RedConnect⁷</td>
<td>✓ (1)</td>
<td>✓ (2)</td>
<td>✓ (1)</td>
<td>✓ (2)</td>
<td>✓ (1)</td>
<td>✓ (2)</td>
</tr>
<tr>
<td>PCS 7 V9.0 SW Media Package SMART⁸</td>
<td>✓ (1)</td>
<td>✓ (1)</td>
<td>✓ (1)</td>
<td>✓ (1)</td>
<td></td>
<td>✓ (1)</td>
</tr>
<tr>
<td>PCS 7 V9.0 AS/OS Engineering SMART (PO unlimited)</td>
<td>✓ (1)</td>
<td>✓ (1)</td>
<td></td>
<td></td>
<td></td>
<td>✓ (1)</td>
</tr>
<tr>
<td>PCS 7 Runtime License AS (PO 100)</td>
<td>✓ (1)</td>
<td>✓ (1)</td>
<td>✓ (1)</td>
<td></td>
<td></td>
<td>✓ (1)</td>
</tr>
<tr>
<td>PCS 7 V9.0 ES Single Station SMART (AS/OS: PO 100)</td>
<td>✓ (1)</td>
<td>✓ (1)</td>
<td></td>
<td></td>
<td></td>
<td>✓ (1)</td>
</tr>
<tr>
<td>PCS 7 V9.0 OS Single Station Redundancy SMART (2x OS RT PO 100)</td>
<td>✓ (1)</td>
<td>✓ (1)</td>
<td></td>
<td></td>
<td></td>
<td>✓ (1)</td>
</tr>
</tbody>
</table>

¹ Win7 64-bit Ultimate preinstalled
² Incl. 1x 1-slot PS UC 120/230V 4A + 1x 4-slot rack; 1x PO 800 System Expansion Card
³ Incl. 2x 1-slot PS UC 120/230V 4A + 2x 4-slot rack; 2x PO 800 System Expansion Card
⁴ Incl. 1-slot PS UC 120/230V 4A + 4-slot rack; IL RT license; AS RT PO 100 license; PO 100 System Expansion Card
Licenses

- incl. 2x 1-slot PS UC 120/230V 4A + 2x 4-slot rack; 1x synch. cables and modules; 1x IL RT license; 1x AS RT PO 100 license, 2x PO 100 System Expansion Card
- Managed Fast Ethernet Version with 8x RJ45; Temperature range (-10°C ... +60°C)
- 8x single/4x redundant connections
- All other necessary licenses for PCS 7 SMART are PCS 7 ASIA licenses.

**Note**

For PCS 7 SMART V9.0, the following products also can be purchased separately:
- PCS 7 V9.0 AS/OS Engineering SMART (PO unlimited) (6ES7658-5AX58-5CA5)
- PCS 7 V9.0 OS Single Station Redundancy SMART (2x OS RT PO 100) (6E7652-3AA58-5CA0)
- PCS 7 OS Single Station SMART (PO 100) (6ES7658-2AA58-5CA0)
- PCS 7 V9.0 ES Single Station SMART (AS/OS PO 100) (6ES7658-5AA58-5CA0)

**Expanding from PCS 7 SMART with control system components**

You can expand the functionality of PCS 7 SMART (e.g. SIMATIC BATCH, SIMATIC Route Control, WebServer, Process Historian, Information Server or Import-Export Assistant). Separate licenses are available for upgrading the additional functions. An overview of the control system components is available in the "SIMATIC PCS 7 Standard Catalog ST PCS 7" catalog in the catalog search [here](http://w3app.siemens.com/mcms/infocenter/content/en/Pages/order_form.aspx?nodeKey=key_516907&infotype=1&linkit=null).

**14 day trial mode**

PCS 7 SMART does **not** include the 14 day trial mode.

**PCS 7 SMART OS demo mode**

PCS 7 SMART changes to demo mode in the following situations:
- When the maximum number of OS process objects (2400 POs) is exceeded
- When a license is missing
- When a USB hardlock is missing

Demo mode limits the use of PCS 7 SMART as follows:
- In demo mode, the WinCC Explorer and the editors end automatically after 60 minutes.
- In the PCS 7 SMART OS runtime, notification windows pop up at regular intervals referring to the active demo mode; these must be confirmed.

**USB hardlock**

The USB hardlock for PCS 7 SMART is intended for use with PCS 7 SMART only. Make sure that the USB hardlock is permanently inserted in the USB port of the computer on which the associated version of PCS 7 SMART is running. If you remove the USB hardlock from the computer during runtime, PCS 7 SMART switches to demo mode.
To avoid losing the USB hardlock, close and lock the front panel of the IPC.

**License upgrade from PCS 7 SMART to PCS 7 ASIA**

A license upgrade from PCS 7 SMART to PCS 7 ASIA is not possible. If you want to use PCS 7 ASIA, you must purchase the appropriate standard license:

<table>
<thead>
<tr>
<th>PCS 7 SMART V9.0</th>
<th>PCS 7 V9.0 ASIA</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS/OS Engineering SMART</td>
<td>AS/OS Engineering ASIA</td>
<td>6ES7658-5AX58-0CA5</td>
</tr>
<tr>
<td>OS Single Station SMART</td>
<td>OS Single Station SN ASIA</td>
<td>6ES7658-2AA58-6CA0</td>
</tr>
<tr>
<td>OS Single Station Redundant SMART</td>
<td>OS Single Station Redundancy SN ASIA</td>
<td>6ES7652-3AA58-6CA0</td>
</tr>
</tbody>
</table>

**Note**
- All other licenses are standard licenses and must not be replaced.

**Updating from PCS 7 SMART to a new PCS 7 SMART version**

You can update as soon as a new version of PCS 7 SMART becomes available.

For more information on updating from PCS 7 SMART V8.1.1 to PCS 7 SMART V9.0, and PCS 7 SMART V8.2 to PCS 7 SMART V9.0 refer to Upgrading to PCS 7 SMART V9.0 (Page 41).

**License upgrade from PCS 7 SMART V8.1.1 to PCS 7 SMART V9.0 and PCS 7 SMART V8.2 to PCS 7 SMART V9.0**

You must upgrade the license packages after upgrading from PCS 7 SMART V8.1.1 to PCS 7 SMART V9.0 and PCS 7 SMART V8.2 to PCS 7 SMART V9.0. You must purchase the following licenses and upgrade the licenses using Automation License Manager:

<table>
<thead>
<tr>
<th>Upgrade packages</th>
<th>MLFB</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCS 7 SMART V9.0 AS/OS Engineering SMART Upgrade</td>
<td>6ES7651-5AX58-5CE5</td>
</tr>
<tr>
<td>PCS 7 SMART V9.0 ES Single Station SMART Upgrade</td>
<td>6ES7651-5AA58-5CE0</td>
</tr>
<tr>
<td>PCS 7 SMART V9.0 OS Single Station SMART Upgrade</td>
<td>6ES7652-5AX58-5CE0</td>
</tr>
</tbody>
</table>

**Limit on number of process objects (POs)**

Process objects are divided into OS POs (process objects of the operator station) and AS POs (process objects of the automation system).

Each PCS 7 SMART bundle comes with 100 OS POs. You can increase the number of POs by upgrading with a license package. The maximum number of process objects (POs) per OS single station system or per PCS 7 SMART project is limited to 2400.

When the number of used POs exceeds the limit of 2400, the following happens:
- AS: AS-OS transfer is not possible
- OS: A notification window pops up and the OS switches to demo mode
Process objects (POs)

The points below apply to the licensing of process objects “POs”:

The following are counted as PCS 7 process objects:

- All SFCs
- All block instances that meet the following criteria:
  - Instance can be controlled and monitored.
  - Instance generates alarms.
  - Instance is not part of the driver library.

These objects are transferred to the OS and must be licensed.

A block that can be controlled and monitored has the attribute "$S7_m_c = true$" in the CFC block properties.

A process object can include one of the following blocks and objects:

- Blocks for operating and monitoring a system
- Objects for automation
- Objects for signal recording and signal processing

You can find additional information on process objects in the documentation [www.siemens.com/pcs7-documentation](http://www.siemens.com/pcs7-documentation) "Software manuals for SIMATIC PCS 7" in the manual "Licenses and configuration limits" manual under “Read Me & Licenses”.

Available license packages (PO licenses)

There are no special PO licenses available for PCS 7 SMART. If you want to expand the number of process objects in PCS 7 SMART, use the PO licenses for PCS 7.

You can choose from the following PCS 7 licenses:

<table>
<thead>
<tr>
<th>Component of process control system</th>
<th>License level</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator station (OS)</td>
<td>PO:</td>
<td>License key &quot;OS RT PO&quot;</td>
</tr>
<tr>
<td></td>
<td>• 100</td>
<td>- Single station system: maximum 2400 POs</td>
</tr>
<tr>
<td></td>
<td>• 1000</td>
<td>- Single station system: maximum 2400 POs</td>
</tr>
<tr>
<td>Archiving with operator station</td>
<td>Archive values:</td>
<td>Maximum number of archive values that can be archived per second with an OS single station system: 500</td>
</tr>
<tr>
<td></td>
<td>• 1500</td>
<td>- Single station system: maximum 2400 POs</td>
</tr>
<tr>
<td></td>
<td>• 5000</td>
<td>- Single station system: maximum 2400 POs</td>
</tr>
<tr>
<td></td>
<td>• 10000</td>
<td>- Single station system: maximum 2400 POs</td>
</tr>
<tr>
<td></td>
<td>• 30000</td>
<td>- Single station system: maximum 2400 POs</td>
</tr>
<tr>
<td>Engineering system (ES)</td>
<td>Downloading the SIMATIC stations PO:</td>
<td>License key &quot;AS RT PO&quot;</td>
</tr>
<tr>
<td></td>
<td>• 100</td>
<td>- Required for download to the AS, but not for test or S7 PLC Simulation.</td>
</tr>
<tr>
<td></td>
<td>• 1000</td>
<td>- Only required once in the case of redundant systems.</td>
</tr>
<tr>
<td></td>
<td>• 10000</td>
<td>- Only required once in the case of redundant systems.</td>
</tr>
</tbody>
</table>
Note
The 100 pre-installed PO licenses can be expanded using the license packages listed here.
The CPU 410 SMART up to 800 POs.
The CPU 410-5H up to 2600 POs (in conjunction with PCS 7 SMART, a maximum of 2400 POs can be used).
The CPU 410 E up to 200 POs.
You can obtain further information on CPU 410-5H in the "PCS 7 CPU 410-5H Process Automation" manual (www.siemens.com/pcs7-documentation) under "Hardware manuals for SIMATIC PCS 7".
## Differences between PCS 7 SMART and PCS 7 ASIA

### 5.1 Differences between PCS 7 SMART and PCS 7 ASIA

### Introduction

This section describes the differences between PCS 7 SMART and PCS 7 ASIA for the release:

<table>
<thead>
<tr>
<th>Component</th>
<th>PCS 7 ASIA</th>
<th>PCS 7 SMART</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Media DVD</td>
<td>● PCS 7 ASIA</td>
<td>● PCS 7 SMART</td>
</tr>
<tr>
<td>Engineering SW</td>
<td>● Available separately</td>
<td>● Only available as PCS 7 SMART bundle</td>
</tr>
<tr>
<td>Languages</td>
<td>● English</td>
<td>● English</td>
</tr>
<tr>
<td></td>
<td>● Chinese (Simplified)</td>
<td>● English and Chinese (Simplified)</td>
</tr>
<tr>
<td>Licensing</td>
<td>● Standard ASIA</td>
<td>● ASIA &amp; SMART</td>
</tr>
<tr>
<td></td>
<td>● ASIA USB hard lock (OS only)</td>
<td>● SMART USB hard lock (ES &amp; OS)</td>
</tr>
<tr>
<td>CPU</td>
<td>● S7-41X</td>
<td>● CPU 410-5H/-SMART</td>
</tr>
<tr>
<td></td>
<td>● CPU 410-5H/-SMART</td>
<td>● CPU 410 E</td>
</tr>
<tr>
<td></td>
<td>● CPU 410 E</td>
<td></td>
</tr>
<tr>
<td>Architecture</td>
<td>● Maximum of 18 servers (redundant)</td>
<td>● Up to 1 redundant single station with a maximum of 6 reference stations</td>
</tr>
<tr>
<td></td>
<td>● Up to 40 clients</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Up to 8 single stations</td>
<td></td>
</tr>
<tr>
<td>OS Process Objects</td>
<td>● Maximum of 12000 POs per OS project on one OS server and 5000 POs per OS single station system</td>
<td>● Maximum of 2400 POs per OS project on one OS single station system</td>
</tr>
<tr>
<td>AS Process Objects</td>
<td>—</td>
<td>● Max 2400 AS RT PO per project</td>
</tr>
<tr>
<td>Multi Project</td>
<td>● Standard</td>
<td>● Maximum of 1 OS project in the multiproject</td>
</tr>
<tr>
<td>Recommended IPC</td>
<td>● IPC 547D / IPC 547E / IPC 547G / IPC 647C / IPC 647D / IPC 847C / IPC 847D</td>
<td>● IPC 347E</td>
</tr>
<tr>
<td>Markets</td>
<td>● World-wide</td>
<td>● China and India only</td>
</tr>
</tbody>
</table>
5.2 Overview of differences

PCS 7 SMART has the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Influence on PCS 7 SMART</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simplified interface</td>
<td>Better overview and simplified operation</td>
</tr>
<tr>
<td>Limited process objects</td>
<td>Maximum of 2400 POs can be used</td>
</tr>
<tr>
<td>No VBA support</td>
<td>Mass data engineering is not supported</td>
</tr>
<tr>
<td>Limited archiving cycle</td>
<td>Minimum Archiving cycle time is up to 500 ms.</td>
</tr>
<tr>
<td>Limited OS channels</td>
<td>Only &quot;Named Connections&quot; (PA CPU)+OPC UA/DA/A&amp;E/HAD(3rd Party)+ProfiBus</td>
</tr>
<tr>
<td>Limited project settings</td>
<td>Only single station projects possible</td>
</tr>
<tr>
<td>No server data</td>
<td>Only single station, server is not supported</td>
</tr>
<tr>
<td>No block lists editor</td>
<td>Read only; editing not possible.</td>
</tr>
<tr>
<td>No WinCC CrossReferenceAssistant</td>
<td>No extra overview available</td>
</tr>
<tr>
<td>Limited PCS 7 project wizard</td>
<td>• Only CPU 410-5H, CPU 410 SMART and CPU 410 E can be selected</td>
</tr>
<tr>
<td></td>
<td>• Only single station projects possible</td>
</tr>
<tr>
<td>Limited text library</td>
<td>• Only English and Chinese (simplified) is supported</td>
</tr>
<tr>
<td></td>
<td>• Read only; editing not possible.</td>
</tr>
<tr>
<td>Text Distributor</td>
<td>The Text Distributor is not supported.</td>
</tr>
<tr>
<td>Limited supported CPUs</td>
<td>Only CPU 410-5H, CPU 410 SMART and CPU 410 E are supported</td>
</tr>
<tr>
<td>Limited WinCC object manager</td>
<td>• Client/server not supported</td>
</tr>
<tr>
<td></td>
<td>• Maximum of 8 single stations supported</td>
</tr>
<tr>
<td>Limited OS project editor</td>
<td>• Maximum of two monitors supported</td>
</tr>
<tr>
<td></td>
<td>• Only &quot;single station projects&quot; possible</td>
</tr>
<tr>
<td>Limited communication</td>
<td>Only S7 connections supported</td>
</tr>
<tr>
<td>SoftNet RedCon SMART included in PCS 7 SMART OS SW products</td>
<td>Coordinated software package</td>
</tr>
<tr>
<td>CFC CPU and licenses</td>
<td>Supports only PA-CPUs; CFC-SMART license and hardlock are required</td>
</tr>
</tbody>
</table>

Note

The limit of 500 archive tags per second is a recommendation. It also depends on the license which the customer has installed.
5.3 Process objects

The number of process objects (POs) per OS single station system or per PCS 7 SMART project is limited to 2400. If the number of used POs exceeds the limit of 2400 POs, you will receive a warning message.

The number of available POs can be increased to a maximum of 2400 by an upgrade with PCS 7 license packages. Special PCS 7 SMART license packages are not available. Use the license packages available for PCS 7.

Note

The number of usable process objects also depends on the CPU used. You can get information on CPU process objects in the section System requirements (Page 9).
5.4 ES - Functions

Multiprojects
The following special note applies to multiprojects in PCS 7 SMART:
- You can only create one OS project.

AS-OS Engineering
PCS 7 SMART checks the number of process objects during data transmission to the OS (WinCC). If the number of process objects is more than 2400, data transfer is canceled and an error message appears.
In this case, reduce the number of configured process objects and transfer the data once more.

Possible connection types between ES and OS
You can configure a connection between ES and OS in NetPro using:
- S7 channels
  - Named connections (for CPU 410-5H, CPU 410 SMART and CPU 410 E)
  - PROFIBUS
- All OPC channels (can only be used on OS, not between ES and OS)
Any other connections are terminated with an error message during the AS-OS transfer.

PCS 7 SMART project wizard
The PCS 7 project wizard supports you during project creation. You have the following limitations compared to the project wizard in PCS 7:
- You can only select CPU 410-5H or CPU 410 SMART or CPU 410 E.
- You can only create single station projects.
5.5 STEP 7

5.5.1 STEP 7 - User interface

The following functions are disabled in the PCS 7 SMART user interface which means they are not displayed, or displayed as grayed out only:

<table>
<thead>
<tr>
<th>Software product</th>
<th>Menu command</th>
</tr>
</thead>
</table>
| SIMATIC Manager  | • File > S7 memory card  
|                  | • PLC > Manage M7 system 
|                  | • PLC > Copy RAM to ROM  
|                  | • Insert > Station > SIMATIC-300 station  
|                  | • Insert > Station > SIMATIC S5  
|                  | • Edit > Project properties → dialog box in "Type" area - the "STEP 7" option cannot be selected  
|                  | • Options > CAx data 
| HardwareConfig   | • Station > Import  
|                  | • Station > Export  
|                  | • PLC > Upload 
| NetPro           | • Edit > Import  
|                  | • Edit > Export |

5.5.2 STEP 7 - Functions

Command interface

The command interface is not available.
5.6 OS (WinCC)

5.6.1 OS (WinCC) - User interface

The following functions have a different functionality in PCS 7 SMART.

<table>
<thead>
<tr>
<th>Function</th>
<th>Restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server data</td>
<td>Server data is not supported as PCS 7 SMART does not have any client-server architecture.</td>
</tr>
<tr>
<td>Text library</td>
<td>The text library can be opened as read-only. The contents cannot be edited.</td>
</tr>
<tr>
<td>Text Distributor</td>
<td>The Text Distributor is not supported.</td>
</tr>
<tr>
<td>WinCC CrossReferenceAssistant</td>
<td>The WinCC CrossReferenceAssistant is not supported.</td>
</tr>
<tr>
<td>Block list editor</td>
<td>The block list editor only offers read access. The contents cannot be edited.</td>
</tr>
</tbody>
</table>
| OS project editor         | • Screen settings  
The view of the OS project editor is limited to a maximum of two screens.  
• Project settings  
PCS 7 SMART only supports single stations projects. This means you cannot change to other project types (e.g., multi-user project). |

5.6.2 OS (WinCC) - Functions

Mass Data Engineering

The use of mass data engineering with VBA in Graphics Designer is not possible. You can use the script languages VBS and ANSI-C in the process pictures without restrictions.

Archiving process data

The number of archived values for each OS single station system should not exceed 500 values per second.
OS interfaces

You can use the following interfaces in the OS project editor:

<table>
<thead>
<tr>
<th>Connection name</th>
<th>Area of application</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7 channels:</td>
<td></td>
</tr>
<tr>
<td>● Named connections</td>
<td>● For CPU 410-5H + CPU 410 SMART + CPU</td>
</tr>
<tr>
<td>● PROFIBUS</td>
<td>410 E</td>
</tr>
<tr>
<td>All OPC channels (UA, DA, A&amp;E, HDA)</td>
<td></td>
</tr>
<tr>
<td>WinCC Sysinfo channel</td>
<td></td>
</tr>
</tbody>
</table>

All other interfaces are not supported.

Web client

A maximum of three web clients are supported with PCS 7 SMART.

Script editor

You can only open global scripts as read-only. You cannot change global scripts.

5.6.3 OS (WinCC) - Supported hardware

Screen

Each OS of PCS 7 SMART supports the use of up to two screens. You can access the screen settings in the menu of the OS project editor.
Differences between PCS 7 SMART and PCS 7 ASIA

5.6 OS (WinCC)
6.1 Installation of PCS 7 ASIA

The setup of PCS 7 ASIA gives you the option to expand PCS 7 SMART to PCS 7 ASIA without uninstalling it.

---

**Note**

Before changing from PCS 7 SMART, save the required projects as an archive in order to be able to migrate them into PCS 7 ASIA.

---

**Note**

Before upgrading, close all programs that are not required and restart your computer.

---

Follow the following steps for upgrading from PCS 7 SMART to PCS 7 ASIA.

1. Insert "DVD 1" of the installation data storage medium of PCS 7 ASIA in the DVD drive of the PC.
2. Launch the "Setup.exe" file.
   The installation wizard starts.
3. Select the preferred language for the installation wizard.
   You can choose between English and Chinese.
4. Click on "Next >".
   A dialog box with information about performing the installation is displayed.
5. Click on "Next >".
   A dialog box for the product information is displayed. Here you have the option to display information about PCS 7.
6. Click on "Yes, I would like to read the notes" to display the information.
   Click on "Next >" to continue with the installation.
   The installation wizard analyses any existing installations of PCS 7 SMART. The analysis may take several minutes. Please wait until the analysis has ended.
   A dialog box with the license agreement is displayed.
7. Activate the check box "I accept the conditions..." to accept the license agreements.
8. Click on "Next >".
   A dialog box with information about the installation methods is displayed.

9. Activate the option button "Install" to continue with the upgrade from PCS 7 SMART to PCS 7 ASIA.

**Note**
Choose "Install", as the process concerns a new installation from PCS 7 SMART to PCS 7 ASIA.
Choosing "Update" will update exclusively the existing product to a later version number, but will not expand the functionality.

10. Click on the "Next >" button.
    A dialog box for the user information is displayed.

11. Allocate the name of the user and the company.

12. Click on the "Next >" button.
    A dialog box with a choice of languages in PCS 7 opens.
    You can choose between English or Chinese. If you have chosen the "English" installation wizard, then the languages "English" and "Chinese" are default and cannot be changed. If you have chosen the "Chinese" installation wizard, the language "Chinese" is a fixed default and "English" can be chosen as an option.
13. Click on the "Next >" button.
A dialog box with information about the type of installation opens.

14. Select the type of installation.
Activate the option button "Package installation" to select the installation scope using packages.
Activate the option button "User-defined installation" to select the installation scope using individual products.
In our case we are choosing the "Package installation".
The installation path is shown in the "Target directory" section.
15. Click on the "Next >" button. A dialog box with selectable "program packages" is displayed.

16. Select the required "program packages" by activating the associated check box. To support all functions of your projects, select at least the packages which will also be used in PCS 7 SMART.
17. Click "Next >".
A dialog box with the selectable programs is displayed.

Only those programs which are contained in the previously selected "Program Packages" will be displayed.
Blue symbols may be shown in front of the entries:
- Blue check mark: The program is already installed on the system.
- Blue Notice symbol: Another requirement must be fulfilled prior to installation. By activating the respective check box, details regarding the requirement will be displayed.
- No blue symbol: The program can be installed.

Note
Additional components may be activated when a component is selected. In this case, the selected component needs the automatically selected components in order for it to function.

18. Click on the "Next >" button.
A dialog box with a summary of automatic system changes which will be executed during the installation is displayed.
If you agreed to the changes, activate the check box "I accept the change to the system settings".
19. Click on the "Next >" button.
   A dialog box with a summary of the components which are to be installed, the required
   storage space and the approximate duration of installation is displayed.

20. If you wish to launch the installation, click on the "Install" button.
    A dialog box with the individual installation steps and the current progress is displayed.
    A dialog box indicating a necessary restart may be displayed.

21. Click on the "OK" button to perform a restart.
    The system is then restarted. The installation will continue automatically after this.
    A dialog box with information regarding a successful installation is displayed.

22. Click on "Finish".
    The upgrade from PCS 7 SMART to PCS 7 ASIA is complete.

Note
You can get information on the licensing of your version of PCS 7 ASIA on the Internet
(www.siemens.com/pcs7-documentation) in the "Licenses and configuration limits" manual
under "Software manuals for SIMATIC PCS 7".
6.2 Migrating projects

On the following pages you will learn how the migration of a PCS 7 SMART project to PCS 7 ASIA is performed.

**Note**

You can only migrate a project with the SIMATIC manager. The entire project is always migrated during a migration.

After migration from PCS 7 SMART to PCS 7 ASIA, the project can only be opened in PCS 7 ASIA. Once a project is migrated, the migration cannot be undone. The restrictions associated with PCS 7 SMART are lifted as a result of migration to PCS 7 ASIA.

---

**Migration from PCS 7 SMART to PCS 7 ASIA**

The migration is performed with an archived project archive in the form of a ZIP file.

**Note**

Archive the desired project before performing the upgrade to PCS 7 ASIA.

When migrating a project archive, the original archive data is maintained and can be used on another PCS 7 SMART system.

---

**Migrating project archives**

**Requirement:**

You have archived the project with PCS 7 SMART and you can access this file from PCS 7 ASIA.

1. Start the SIMATIC Manager.

2. Select the menu command File > Retrieve. The "Retrieve" dialog box opens.

3. Select the project archive (zip file) in the file system.
4. Click "Open".
The "Select destination directory" dialog box opens.

5. In the file system, select the folder into which you wish to extract the project files.

6. Click the "OK" button.
The "Retrieve" dialog box opens.

7. If you agree, click on the "Yes" button.
The project is converted to PCS 7 ASIA format and saved in the selected folder.
The "Retrieve" dialog box opens and confirms that the migration of the project files.

8. Click on the "OK" button.
The migration is completed.
The project can now be opened in PCS 7 ASIA.
All I/O devices supported by PCS 7 are also supported in PCS 7 SMART.

The table below lists the PA SMART products:

<table>
<thead>
<tr>
<th>Product name</th>
<th>Description</th>
<th>Article No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>DI32</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8DK80-0AA0</td>
</tr>
<tr>
<td>DI32-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8DK80-1AA0</td>
</tr>
<tr>
<td>DI16 Diag</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8DK70-0AA0</td>
</tr>
<tr>
<td>DI16 Diag-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8DK70-1AA0</td>
</tr>
<tr>
<td>DO32</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8EK80-0AA0</td>
</tr>
<tr>
<td>DO32-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8EK80-1AA0</td>
</tr>
<tr>
<td>DO16 Diag</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8EK70-0AA0</td>
</tr>
<tr>
<td>DO16 Diag-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8EK70-1AA0</td>
</tr>
<tr>
<td>AI8 Diag</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8AK60-0AA0</td>
</tr>
<tr>
<td>AI8 Diag-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8AK60-1AA0</td>
</tr>
<tr>
<td>AI16 Diag</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8AK70-0AA0</td>
</tr>
<tr>
<td>AI16 Diag-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8AK70-1AA0</td>
</tr>
<tr>
<td>AI TC/RTD</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8AR60-0AA0</td>
</tr>
<tr>
<td>AI TC/RTD-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8AR60-1AA0</td>
</tr>
<tr>
<td>AO8 Diag</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8BK60-0AA0</td>
</tr>
<tr>
<td>AO8 Diag-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8BK60-1AA0</td>
</tr>
<tr>
<td>IM153</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8PH00-0AA0</td>
</tr>
<tr>
<td>IM153-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8PH00-1AA0</td>
</tr>
<tr>
<td>RWB PS-IM</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8PA00-0AA0</td>
</tr>
<tr>
<td>RWB PS-IM-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8PA00-1AA0</td>
</tr>
<tr>
<td>RWB IM-IM</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8PB00-0AA0</td>
</tr>
<tr>
<td>RWB IM-IM-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8PB00-1AA0</td>
</tr>
<tr>
<td>RWB IO-IO</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8PC00-0AA0</td>
</tr>
<tr>
<td>RWB IO-IO-coated</td>
<td>ET 200PA SMART module</td>
<td>6ES7650-8PC00-1AA0</td>
</tr>
<tr>
<td>CPU 410 SMART</td>
<td>Interfaces:</td>
<td>6ES7 410-5HN08-0AB0</td>
</tr>
<tr>
<td></td>
<td>• PROFIBUS DP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2x2 port PROFinet</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Work memory (7.5 ns SMART card):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Up to 8 MB</td>
<td></td>
</tr>
</tbody>
</table>

CPU 410 SMART

Interfaces:
- PROFIBUS DP
- 2x2 port PROFinet
- Work memory (7.5 ns SMART card):
- Up to 8 MB
8.1 Upgrading to PCS 7 SMART V9.0

Upgrade procedure

Perform the following steps to upgrade PCS 7 SMART V8.x to PCS 7 SMART V9.0:

Note
PCS 7 SMART V8.x refers to PCS 7 SMART V8.1 onwards

Note
Before you upgrade the software:
1. We recommend, you archive your projects to prevent loss of data.
2. Close all running applications and restart your computer.

1. Insert "DVD_1" of PCS 7 SMART V9.0 installation into the DVD drive of the PC.
2. Launch the "Setup.exe" file.
   The installation wizard starts.
3. Select the preferred language for the installation wizard.
   You can choose between English and Chinese.
4. Click "Next >".
   Information about performing the installation is displayed.
5. Click "Next >".
   Information about the product notes is displayed.
6. Click "Yes, I would like to read the notes." to open the readme file. The readme file opens in the default Internet browser.
7. In the installation wizard, click "Next >" to continue with the installation.
   The installation wizard analyzes any existing installations of PCS 7 SMART. The analysis may take several minutes. Once the analysis ends, the license agreement is displayed.
8. Select the check box "I accept the conditions..." to accept the license agreements.
9. Click "Next >".
   The setup type options are displayed.

10. Select the "Update" option.

11. Click "Next >".
   The language options for the product are displayed.
   If your installation wizard is running in "English", the language "English" is selected by default and cannot be changed. Optionally, you can choose the language "Chinese".
   If your installation wizard is running in "Chinese", the languages "English" and "Chinese" are chosen by default and cannot be changed.
12. Click "Next >".
A list of components to be updated is displayed:

The blue arrow mark indicates that the component is already installed on the PC and will be updated.
All the components are selected by default.

13. Click "Next >".
The license agreement is displayed.

14. Select the check box "I accept the conditions..." to accept the license agreements.

15. Click "Next >".
A summary of automatic system changes which will be executed during the installation is displayed.

16. Select the check box "I accept the change to the system settings".

17. Click "Next >".
A summary of the components which are to be installed, the required storage space, and the approximate duration of installation is displayed.

18. Click "Install".
The product upgrade starts. The individual installation steps and the current progress is displayed.
A dialog box prompting a necessary restart may be displayed.
19. Click "OK" to perform a restart.
   The system restarts and the installation continues automatically.
   A dialog box with information regarding a successful installation is displayed.

20. Click "Finish".
   The upgrade from PCS 7 SMART V8.x to PCS 7 SMART V9.0 is complete.

For information on upgrade licenses for PCS 7 SMART V9.0, refer to Licenses (Page 17).
Index

A
Archiving
  OS, 28
AS-OS Engineering
  ES, 26
Automation systems
  Hardware Requirements, 9

B
Bundles
  License, 17

C
Command interface
  STEP 7, 27
Comparison
  CPU, 9
CPU
  Comparison, 9
  Process objects, 10

D
Demo mode
  License, 18
Differences
  PCS 7 SMART, 24

E
ES
  AS-OS Engineering, 26
  ES OS connection, 26
  Hardware catalog, 39
  Multiprojects, 26
  Project wizard, 26
ES OS connection
  ES, 26

H
Hardware catalog
  ES, 39
Hardware Requirements
  Automation systems, 9
  PC, 9

I
Installation
  PCS 7 ASIA, 31
  PCS 7 SMART, 16
Interfaces
  OS, 29

L
License
  Bundles, 17
  Demo mode, 18
  Process object, 19
  Technology components, 18
  Trial mode, 18
  Upgrade to PCS 7 ASIA, 19
  Upgrade to PCS 7 SMART V9.0, 19
  USB hardlock, 18

M
Mass Data Engineering
  OS, 28
Migration, 37
Multiprojects
  ES, 26

O
Operating system
  System requirements, 13
OS
  Archiving, 28
  Interfaces, 29
  Mass Data Engineering, 28
  Screen, 29
  User interface, 28
### Index

**P**
- Hardware Requirements, 9
- PCS 7 ASIA
  - Installation, 31
- PCS 7 SMART V9.0
  - Upgrade, 41
- PCS 7 SMART
  - Installation, 16
  - Process objects, 25
- Process object
  - License, 19
- Process objects
  - CPU, 10
  - PCS 7 SMART, 25
- Project wizard
  - ES, 26

**S**
- Screen
  - OS, 29
- SEC, 10
- STEP 7
  - Command interface, 27
  - User interface, 27
- System configuration
  - System requirements, 13
- System expansion card, 10
- System requirements
  - Operating system, 13
  - System configuration, 13

**T**
- Technology components
  - License, 18
- Trial mode
  - License, 18

**U**
- Upgrade
  - PCS 7 SMART V9.0, 41
- Upgrade to PCS 7 ASIA
  - License, 19
- Upgrade to PCS 7 SMART V9.0
  - License, 19

### Additional Entries
- USB hardlock
  - License, 18
- User interface
  - OS, 28
  - STEP 7, 27